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Microsoft Excel 2016: Part 3  
Setting Up Workbooks And  

Intro to Excel Formulas 
 

 
 

Setting Up a Workbook: 
 

You can set up the workbooks a certain way 

before you print out by using the Page 

Layout tab or by using the Page Layout 

View at the bottom right corner.  The 

commands on the tab will let you change 

page orientation, paper size and margin 

size. You may also insert page breaks and 

repeat certain header row(s) to make your workbook easier to read.  You can also launch the Page 

Setup dialog box and find more commands for the tab.   

Note: Make a cell in the first column as your active cell or select an entire row if you wish to place a 

page break below that row by using the Breaks command on the ribbon. 

It is easier to use the Page Layout View at the bottom right corner to insert the Headers and the Footers 

visually.   

Setting Page Orientation: 
Excel offers two page orientation options: landscape and portrait. Landscape orients the page 

horizontally, while Portrait orients the page vertically. Portrait is especially helpful for worksheets with a 

lot of rows, while Landscape is best for worksheets with a lot of columns.  

Exercise:  Select January worksheet from the same ExcelPart3.xlsx to practice. 

 Change the view to see the worksheet in the Page Layout View at the bottom right 

corner. 

 Use the Orientation on the Page Layout tab to view in Landscape. Change it back to 

the Portrait view and see which looks better for this example. 

 Since we have more rows than columns in the worksheet, Portrait view is better 

for our example. 
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Portrait View   Landscape View 

  

Setting Page Margins:  
A margin is the distances from the edge of the page to the content on your page. By default, every 

workbook's margins are set to Normal, which is a one-inch space between the content and each 

edge of the page. Sometimes you may need to adjust the margins to make your data fit more 

comfortably on the page. Excel includes a variety of predefined margin sizes. 

Exercise:  Use the same January worksheet to practice. 

 

 

 Click on the Page Layout view button on the bottom right corner of the screen. Then click on 

the Page Layout tab on the Ribbon and select the Margins command.  

 Select the desired margin size from the drop-down menu. Select the Wide margin for our 

example to see how it looks to have a wider margin for the workbook. 
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 You may also select the Custom Margins command.  Page Setup dialog box will be 

activated.  Change the numbers of the Left, Right, Top, and Bottom to customize your 

margin width. 

 You may also change the numbers under Header and Footer boxes to specify how much 

space do you want to keep between the edge of the paper and either a header or a footer. 

 You can also specify how much you want to see your data centered on your worksheet 

printout.  This is especially useful if you do not have much data. 

Setting Print Area: 

Use the same workbook to practice this function.  This command is especially 

useful if you want to print the subset of your huge data. 

 Keep the worksheet in the Layout view.   

 Select Cells A1:D8 to set as the Print Area. 

 Click on the arrow on Print Area command and select Set Print Area.  

No matter how large your data is, you are just setting to print that selection 

only. 

 Click on Print Area one more time and select Clear Print Area to clear the chosen print area. 

 

Inserting or Removing Page Breaks 
You can add a break where you want the next page to begin in the 

printed copy.  Your page break will be inserted above and to the left 

of your selection. 

 Keep the worksheet in the normal view.  We want to start a 

new page beginning row 16. 

 Click on Cell A16 or select the entire row 16. (It is important you 

select the entire row or click the cell in the first column of the row to 

insert a page break.)  

 Click on Insert Page Break.  Click it away from row 16 and you should see the page break line 

above row 16.   

 Remove Page Break – you need to select a cell right below the page break line to use this.  In 

this example, entire row 16 or any cells on row 16.  

 Reset All Page Breaks – your cell selection can be anywhere on your worksheet.  By clicking this 

will reset all page breaks you put on your worksheet regardless of your selection. 
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 You can also view your worksheet in the Page Break 

Preview  by clicking on the last button 

at the bottom right corner.  You shall see the page with 

solid dark blue lines as the page breaks.  In this view, you 

can also move the breaks by pointing onto the lines and 

drag the mouse to the new location – up/down or 

left/right. Default page breaks lines are represented by 

the dotted dark blue lines and the manually created one 

has solid dark blue lines just like the boundary lines.   

    

Page Break Preview 

Printing Titles or Repeating Rows at the Top: 
If your worksheet uses title headings, it's important to include these headings on each 

page of your printed worksheet. It would be difficult to read a printed workbook if the title 

headings appeared only on the first page. The Print Titles command allows you to select 

specific rows and columns to appear on each page.   

 

Exercise: Use the same worksheet – January and go back to normal view from the bottom right. 

 Click on Print Titles command from the Page Setup tab.  Page Setup dialog box will come up.   

 Click on the red arrow for the box says – Rows to repeat at the top as shown below. (Note:  you 

can also use the function Columns to repeat at left if you need the print out with repeated 

column(s) on every page.) 

  
 The Page Setup dialog box will be resized to a smaller size as shown in the picture below. 

  



 

Copyright © 2020 ASCPL All Rights Reserved  Page 5 of 15 MS2016-ExcelPart3 MMS 9/1/2020 
 

 To repeat the first row in our example where column headings are, click on Row Number 1 and 2 

as if you are selecting the entire Rows 1 and 2.  The row selection will show as dotted moving 

lines. And the selection of the Row 1 will appear in the box as $1:$2 to indicate that we are 

selecting to repeat Rows 1 and 2 on the top of every printed page.  

 Click on the red arrow and the Page Setup box should open again. 

 Click on Print Preview button to see that the header row is repeated on every page of the print 

out. 

 Gridlines: Cell gridlines you see on screen will not print out unless you 

check out the Gridlines box in Page Setup box.  This can be used 

alternative to setting Borders in cell. 

 Row and column headings:  If you desire to include the column names 

such as A, B, C and the row numbers 1, 2, 3 in your printout, check this box. 

 

 

 

 

 

Inserting Headers and Footers: 
The header is a section of the workbook that appears in the top margin, while the footer appears in 

the bottom margin. Headers and footers generally contain information such as page number, date, 

and workbook name that you want to repeat on every page.  It is easier to insert headers and 

footers while in the Page Layout view .  

 

Exercise:  Use the same worksheet January above. 

 Click on the Page Layout view on bottom right corner.   

 Click in one of the three sections (left, middle, or right) appear in the header section of our 

worksheet.  You should see  Header & Footer Tools tab will appear on the Ribbon.  Click on the 

Design tab. 

 
 From here, you can access commands that will automatically include page numbers, dates, 

and workbook names in any of the three sections. 
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 Click on the Current Date command in the left section. 

 Click in the middle section and type in your name. 

 Click in the right section and then click on the Page Number command on the ribbon. 

 You can click in the bottom part of the page to switch to the Footer Section and insert these 

commands or enter anything. 

 

Printing 
 To access the print pane, click on File menu on top.  Click on print command. 

 Print Preview will be shown as below. 

 
 

1. Printer: If your computer is connected to multiple printers, click on the drop-down and 

select the printer. 

2. Print Active Sheets:  If your workbook has more than one worksheets 

and you want to print multiple worksheets, activate the worksheets 

first before you get to this Print Preview pane and select Print Active 

Sheets. Or select Print Entire Workbook OR choose Print Selection if 

you just highlighted a block of data to print.   

3. Pages:  You can specify particular pages to print by selecting page 

numbers in these two boxes. 

4. Collated: If you are printing multiple copies, you can choose whether you want the copies 

collated or uncollated.  

5. Portrait Orientation: Choose Portrait or Landscape. 
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6. Letter: If your printer uses different paper sizes, you can select 

your paper size here. 

7. Custom Margins: Here you can adjust the page margins to fit 

the data better. 

8. No Scaling: Scaling helps you to make small adjustments from 

the Print pane to fit your workbook content neatly onto a 

printed page.  Note:  Worksheets will become more difficult 

to read as they are scaled down, so you may not want to use 

this option when printing a worksheet with a lot of 

information. 

9. Flipping through pages: Use right and left arrows to print 

preview your workbook with multiple pages to print. 

 

10. Show Margins:  Use this to 

view and adjust margins 

visually in print preview pane.  

The page margins will appear 

in the Preview pane. (See 

picture on right) Hover the 

mouse over one of the 

margin markers  until the 

cursor becomes a double 

arrow . In our example, we'll 

extend the left margin to 

place the spreadsheet more 

towards the center of the 

page. 

11. Copies:  Verify the number of 

copies you wish to print here. 

12. Print: If you’re satisfied with all the adjustments you have made, click on Print to print your 

worksheet(s) or workbook.  
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Introduction to Formulas:  
Just like a calculator, Excel has the ability to calculate numerical information using formulas. Excel 

can add, subtract, multiply, and divide. In this lesson, we'll show you how to use cell references to 

create simple formulas. 

Note:  All formulas start with the ‘=’ equal sign.  This is because the cell contains, or is equal to, the 

formula and the value it calculates. 

 

 

 

Understanding Cell Reference: 
As shown in the table above, you can simply create formulas manually by typing in fixed numbers to 

get calculation.  However, most of the time, you will use cell addresses to create a formula. This is 

known as making a cell reference. Cell reference identifies individual cells, rows, and/or columns in 

a worksheet.  They tell Excel where to look for values to use in a formula.  Using cell references will 

ensure that your formulas are always accurate because you can change the value of referenced cells 

without having to rewrite the formula. 

 

To practice, open up add a new worksheet by clicking on the + sign in sheet tab area in same 

workbook ExcelPart3.xlsx.  Enter 10 in Cell A1 and 5 in Cell A2.  Instead of typing in =10+5 to get the 

result in Cell A3, you can use Cell addresses to get the same result.  See the formula entered into 

Cell A3 (Figure 1) displays the answer to the equation =A1+A2 in Figure 2.  If any value in those 

referenced cells (A1 or A2) changes – such as changing the value in Cell A1 to 20, the result cell A3 

will automatically recalculates for you as shown in Figure 3.  

 

 

 

 Figure 1     Figure 2    Figure 3 

 

Addition + =10+5

Substraction - =10-5

Multiplication * =10*5

Division / =10/5
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By combining a mathematical operator with cell references, you can create a variety of simple 

formulas in Excel. Formulas can also include a combination of cell references and numbers, as in the 

examples below: 

Cell Ref Meaning Practice 

=F2-1 Subtract 1 from Cell F2 In cell C1, enter =A3-1 

=G2/F2 Divide Cell G2 by Cell F2 In cell C2, enter =A3/A2 

=F2*1.5 Multiply Cell F2 by 1.5 In cell C3, enter =A3*1.5 

 

Basic Mathematical Functions 

AVERAGE Finds the average within a range of cells. =AVERAGE(A10:A20) 

MAXIMUM Finds the largest number within a range of cells. =MAX(D3:D15) 

MINIMUM Finds the smallest number within a range of cells. =MIN(D3:D15) 

SUM Finds the total or sum within a range of cells. =SUM(A10:A20) 

 

To Create a Formula Using the Point-and-Click Method: 
Rather than typing cell addresses manually, you can point and click on the cells you wish to include 

in your formula. This method can save a lot of time and effort when creating formulas.   

Exercise:  Use Monthly Budget worksheet to practice some formulas in same workbook.  

1. Enter a formula to add all income lines.  Three ways 

to add income lines: 

o Select Cell B13. 

o Type in the equal sign “=”. 

o Point and click individual cells to be included 

in the formula as shown. Type in “+” sign 

after each cell is selected except in the last 

cell. 

OR 

o Select Cell B13. 

o Click on AutoSum function in Editing 

group. 

o Fix the formula to include all cells to be 

included in the formula by either typing or 

using your mouse function.  
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OR 

o Select Cell B13. 

o Type in the equal sign “=”.   

o Type in “ SUM(“ and point and click to 

select all cells to be included in the formula as shown. Type in “,” after each cell 

reference and “)” at the end of the formula. 

As you can see, there are more than one way to address cell references in the formula.  The followings 

are examples on cell references. 

Other Examples on Cell References: 

 

Cell references Refer to values in 

A10 the cell in column A and row 10 

A10,A20 cell A10 and cell A20  as in =SUM(B8,B9,B10,B11,B12) 

A10:A20 the range of cells in column A and rows 10 through 20 as in =SUM(B8:B12) 

B15:E15 the range of cells in row 15 and columns B through E 

A10:E20 the range of cells in columns A through E and rows 10 through 20 

 

2. Select cell B37.  Use the AutoSum function  to total all expenses in that 

column (Cell B19 through B36). 

To reference cells or link data in same or across worksheets 
Excel allows you to refer to any cell on any worksheet, which can be especially helpful if you want to 

reference a specific value from one cell to another in the same worksheet or in another workbook.  If a 

value changes in the source cell, the change in reflect in the result cell automatically. 

 

3. Select cell B43.  In this cell, we want to have our total income figure from cell B13 appear.  

So we will link cell B43 to cell B13.  In other words, we will reference this cell B43 to cell B13 

in the same worksheet. 

o Linking is like entering a formula.  It begins with an equal sign.  And the formula 

begins where you want to see the result.  In this case, we want to see the total 

income figure in cell B43.   

o Select cell B43. 

o Type in equal “=” sign.    

o Then click the reference cell B13. 

o Press Enter on your keyboard. The value of the 

referenced cell will appear in cell B43.  
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o Apply the same method and link Cell B44 to cell B37.  

o Test to change the Salary figure in cell B8 to 2600.  You will see the immediate 

change in related cells B13 and referenced cell B43.  

o Enter the subtraction formula in cell B45 to find out Difference (Income-Expenses). 

 

Trace Precedents and Dependents: 
Sometimes, checking formulas for accuracy or finding the 

source of an error can be difficult when the formula uses 

precedent or dependent cells.  For practice, let’s use the 

same workbook. 

 Trace Precedents shows arrows that indicate 

which cells affect the value of the currently 

selected cell. In our example, if you want to 

check which are the values that affect the 

value in cell “B45”, this is where “Trace 

Precedents” help. Select B45. Go to the 

Formula tab and select Trace Precedents.  You will see the blue line pointing out the cells (Cell 

B43 and B44) that can affect the value in cell B45.  Click Trace Precedents again since it runs the 

precedents in recursion, and blue line extends to cell B37 (Total Expense) and B13 (Total 

Income).  Clicking on Trace Precedents one more time will extend to include all those rows in 

the expense column and all rows in income column which creates values in Cell B13 and B37. So 

if any of the value in income and expense cells changes, cells B13, B37 and ultimately B45 will be 

affected.   

To remove the arrows, use the “Remove Arrows” button from “Formulas” toolbar. 

 Trace Dependents does exactly the opposite. This option shows which are the cells affected by 

values from this cell. In our example let’s take a look at cell “B8”.  Click on Trace Dependents. You 

will see cell B13 (Total income) depends on it.  Click Trace Dependents again since it runs the 

dependency in recursion, and another arrow pointing to cell B43 indicates the value in cell B43 is 

also depending on the value in cell B13. Clicking on Trace Dependents one more time will show that 

value in cell B45 is depending on cell B43.  So if value in cell B8 changes, values in cells B43 and B45 

will be affected.   

To remove the arrows, use the “Remove Arrows” button from “Formulas” toolbar. 
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Relative and Absolute Cell References: 
There are two types of cell references: relative and absolute. Relative and absolute references 

behave differently when copied and filled to other cells. Relative references change when a formula 

is copied to another cell. Absolute references, on the other hand, remain constant, no matter where 

they are copied. 

Relative Cell References:  By default, all cell references are relative references. When copied across 

multiple cells, they change based on the relative position of rows and columns. For example, if you 

copy the formula =A1+B1 from row 1 to row 2, the formula will become =A2+B2. Relative references 

are especially convenient whenever you need to repeat the same calculation across multiple rows or 

columns.  Let’s verify this by opening the Grocery worksheet in same workbook.   

 Select cell F2. 

 Enter the formula to find the total 

cost of row 2 for oranges.  (Total 

cost = Qty * Price) 

 The formula should be =C2*E2 as 

shown. 

 

 When we copied this formula from cell 

F2 to the lower cell F3 by using the Fill 

Handle, the cell reference changed 

based on the relative position of the 

row – in this case, Row 3.  So, the 

copied formula becomes =C3*E3  

 

 Select cell F3 again; use the Fill Handle, 

and copy the formula to all lower cells 

by dragging the mouse or double-

clicking the mouse.  Remaining rows 

now will have copied formulas with the 

cell references changed to the relative 

position of their row numbers.  

 

 

 Format column E (price column) and column F (total cost column) in accounting number 

format with $ sign. 

 

To Edit a Formula: 
When you need to edit an existing formula, you can do so in a number of ways.  Let’s assume we are 

going to edit our formula in Cell F2 in Grocery worksheet to include the markup of 10%.  That would 

require to multiply the original formula =C2*E2 with 1.1 as =C2*E2*1.1.  To do this, follow these steps. 
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 Double-click on Cell F2 

where we entered our 

original formula.  The 

cursor should be blinking 

at the end of the existing 

formula. (If not, move 

your cursor to the end of 

the existing formula.)      

 Then type in the multiplication symbol “*” 

and “1.1” as shown.   

OR 

 You can also click directly in the formula bar 

area to fix the formula. When finished, hit 

Enter key on your keyboard or select the 

Enter command  in the formula bar. 

 
 In either case the calculated value will show in Cell 

F2.           

 Undo your change by clicking on the undo 

command on quick access toolbar or Control+Z.    

 

Absolute Cell Reference: 
There may be times when you do not want a cell reference to change when filling cells. Unlike 

relative references, absolute references do not change when copied or filled. When you want to 

keep a row and/or column constant, use an absolute reference. 

An absolute reference is designated in a formula by the addition of a dollar sign ($). It can precede 

the column reference, the row reference, or both.  See the examples, below. 

Used generally more than 

 the other two formats. 
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When writing a formula, select the cell you want to change and press the F4 key on your keyboard 

to switch between relative and absolute cell references. This is an easy way to quickly insert an 

absolute reference.  Let’s do the exercise below. 

o Select cell H1. 

o Click on the % sign in the Number group to indicate that you are formatting cell H1 

content as percentage. 

o Enter number 8 in cell H1. 

o You will see 8% in cell H1.  Consider this number as a discount you are going to apply to all 

rows in Total Cost column. 

o Select cell H2. 

o Enter the formula  =F2*H1 (by pointing and clicking on those cells). Then hit function key 

F4 before you hit the Enter button. Your formula would change from =F2*H1 to =F2*$H$1 

 

o Select cell H2 again.  Use the Fill Handle and copy the formula to the rows below.  

Examine each cell from H3 onward.  The first cell reference changes to the relative cell 

from F2 to F3, F4 and so on relatively.  However, the second sell reference $H$1 stays the 

same no matter what row you are looking at.   

Subtotal Data 

When you have a list of data in a column, just like you have in Grocery worksheet, you can automatically 

calculate subtotals and grand totals by using the Subtotal command in the Outline group on the Data 

tab.  You may want to find out the subtotal for Produce, Meat, Dairy, etc.  Keep the data you want to 

subtotal in the furthest left column – in this example “Category” as we want to find out the subtotals on 

each category. You can find Sum or Average or more in the SUBTOTAL.   Let’s 

practice by using the Grocery worksheet. 

 Click anywhere on the data first. 

 Click on Data>Subtotal command in the Outline group.  
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 Subtotal window will pop up. In here you can select Sum, Average, 

etc. under the Use Function.  We will select Sum as we want to 

find out total on each category. 

 Select “Total Cost” and “8%” columns to subtotal figures in those 

two columns.  (Note:  you want to select only those boxes where 

adding, counting, finding averages provide meaningful data.  In 

here checking the “Brand/Comments” column will not provide any 

meaningful data. In other words, select the data that is calculable.) 

 Click on OK button. 

 Once you created the Subtotals, you will see the outline symbols 

at the upper left corner of the worksheet. 

 

 

 

 

 

 The highest number Level 3 gives you the most detailed with Subtotals for each category with 

the Sum figures for selected boxes – Total Cost and 8% columns. 

 Clicking on the Level 2 will only provide Subtotals for each category hiding the details on each 

row. 

 Clicking on the Level 1 will only provide the Grand Totals for the entire sheet. 

 (To remove subtotals, click the Subtotals command again and click the “Remove All” button in the 

Subtotals box.) 

 

 

 


